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Vintage Designs for the Endless Hoop 
By Debra Bohn  

 

Sometimes we think that if we can’t draw, we cannot create our 
own unique designs. It is easy to create your own designs using 
motif stitches, shapes and encore. Let’s explore three modules in 
the 5D™ Suite: 5D™ Embroidery Extra, 5D™ Sketch and 5D™ 

Design Creator to create a home dec endless vintage design. 

 
Reset All Modules 

1. Open 5D™ Embroidery . 

2. QuickLink to 5D™ Configure . 

3. Click on Reset All Modules. 

4. Click OK to the message, ‘All modules will be closed and reset to their default 
settings’. 

5. When you see the message, ‘Please confirm that all modules except 5D™ Configure 
are now closed’, ensure no other modules are open in the background. If they are, 
click on the module(s) in the background, and close after saving any work that might 
be in progress. Click OK to the ‘All modules will be closed’ message when you have 
verified all other modules are closed. 

6. Click OK to the message, ‘All modules are now reset to their default settings’. 

7. Click OK to close 5D™ Configure. 

 

Getting Started in 5D™ Embroidery Extra 

1. Open 5D™ Embroidery .  

2. You will see the message, Please Wait while configuring the software for the current 
user.  

3. Click Hoop  . Select Enter Hoop Size, and make Height 260mm and Width 
150mm to make an embroidery that will fit the creative™ Grand Endless Hoop.   

4. Click OK to close Hoop Selection.  
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5. Click on Preferences . Set the Grid size to 10mm.  

6. Uncheck Remove Overlap When Combining. 

7. Click OK to close Preferences. 

 

Creating a Design Using a Motif in 5D™ Embroidery Extra 
1. Select on the Motif tab in the Control Panel on the upper right of the screen. 

2. Under Motif, leave the Group on Universal. 
3. Click on the down arrow next to Category. Select Hand Stitches 1. 

4. Click on the down arrow next to Pattern. Select Pattern 2. 

5. In the Size box, make sure Proportional is checked. 

6. Change the Width to 14.0mm. The Height will change proportionally. 

7. Click Apply. 

8. Select the Design tab in the Control Panel on the upper right of the screen. 

9. Click Encore . 

10. In Encore, select Line for the Type. 

11. For Line Options, select 3.  

12. Enter 20 in the Number of Repeats box. 

13. Click OK. 

14. Hold your mouse down and move the solid blue square in the middle of the box 
down until the selection box is about 50mm from top to bottom.  

With the Grid set at 10mm, that means we will have five grid spaces. 

15. Right mouse click to set the design.  

16. Click Rotate 90° . 
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17. Click and drag, or nudge with the arrow keys, until the upper 
end of the embroidery is exactly over the vertical bold center 
gridline.  Use the Zoom toolbar as needed to ensure the last 
stitch at the top of the element is centered over the vertical grid. 

18. Click and drag the Center of Rotation  until its cross-hair is 
over the end of the top stitch. 

19. Click Zoom to Fit .   

20. Click Zoom In .  Click and drag a box around the lower half of 

the selected design, so you can see the Free Rotate handle  and the bottom of 
the last stitch. 

21. Click and drag the handle to rotate until the last stitch in the line 
of motifs is directly over the bold vertical center gridline, to ensure 
the design will align seamlessly when made into an endless 
embroidery. 

22. Click Center in the Hoop .  

23. Click Save As . Save design as ‘Vintage Center Design’.  
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Creating a Design Using a Motif in 5D™ Design Creator 

1. Select 5D™ Design Creator  in the QuickLink toolbar.  

2. The ExpressDesign Wizard- Choose Design Type opens. 

3. Select the last option, Start a New Design with no Picture. 

4. Click Next. 
5. On the Select Background Type window, select Draw Window. 

6. Click Next. 
7. On the Design Size window, select Change Hoop. 

8. In the Enter Size box, select Enter Hoop Size. 

9. Change the Width to 40mm and the Height to 35mm. 
10. Click OK. Click Finish. 

11. Select Preferences .   

12. Click the Screen tab. Change the Grid size to 5mm.  

13. Click OK to close Preferences. 

14. In the Color Select box, make sure Fills indicator (directly under 
Color Select) does not have an X in it, meaning no fill. If there is an 

X in Fills, click on the Fills button  below the color select area to 
change the X to a fill.  

15. Right click on a color to change the color of the fill.  

16. In the Color Select box, make sure Lines does have an X in it, meaning no outline. If 
there is not an X in Lines, click on the Lines button to change the Color Select Line 
to an X.  

17. In the Create box, click on Shapes .  

18. To the left of the Create box click on the drop down arrow next to a Square 
#1 shape. Select Shape 12. 

19. Make sure the first option, the X in the middle of the shape, is selected. 
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20. Starting in the center of the gray cross, drag your mouse to the right and down, until 
the selection box is one full grid space from the blue hoop corner 
guidelines.  

21. Click Select All . 

22. Click Center in Hoop . 

23. Click Save as Drawing . Save picture as ‘Filled Shape’. Click Save. 
24. Click the Create tab on the upper left. 

25. Click Color Change . From the Thread Ranges, select Robison-Anton Rayon 
40. 

26. In the Quick Colors box, select the lightest green from the Standard theme, 2516 
Aqua Pearl. Click OK. 

27. In the Fill Area box, click on the down arrow next to the Satin Line . Select 

Double Stitch . 

28. In Fill Area box, click on the down arrow next to Pattern Fill . Select Motif Fill 

. 

29. Click Options. 

30. In the Motif box in the Motif 1 tab, select Universal for the Group. 

31. Select Hand Stitches 2 for the Category. 

32. Select Pattern 23.  

33. Change the Height and Width to 9mm. Click OK. 

The size was determined by trying several different sizes until 
the fill shape looked nice. 

34. Click QuickStitch Fill . 

35. Click in the Shape. A red and blue line traces the shape. 

36. On the upper left click OK in the Color Tolerance box.  

37. Right mouse click to turn the QuickStitch Fill tool off. 

38. Click Save Embroidery . Save as ‘Petal’. 
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39. Click Copy . Is the design visible in the Clipboard? If not, click Copy  again.  

40. QuickLink back to 5D™ Embroidery. 

41. Click Paste . 

If you do not have 5D™ Design Creator , load the file ‘Petal.vp3’ into 5D™ 
Embroidery.  

42. Click Encore . 

43. In Encore, select Circle for the Type. 

44. Enter 5 in the Number of Repeats box. Click OK. 

45. Drag the petals to an open space in the hoop. 

46. Move the Zoom slider on the lower right of the screen, to around 60%. 

47. Click on the Overview tab and Pan  so you can see the petals clearly. 

48. Drag from the top petal downward until the five petals almost touch each other. The 
center of the petals is shaped like a star.  

49. Right click to set the petals. 

50. Click Zoom To Fit , or adjust the view with the Zoom slider. 

51. Move the petals to the lower left side of the center design. Rest the top selection 
box on the second grid line from the horizontal bold center line and the right side 
of the select box against the vertical center. 

52. Click Duplicate . 

53. Move the second petal design to the upper right using the Grid. 
Rest the top selection box on the second grid line from horizontal 
bold center line and the left side of the select box against the 
vertical center. 

54. Click Save As . Save design as ‘Vintage Center Design and 
Petals’.  
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Creating a Design Using Motifs in 5D™ Sketch 
1. In the QuickLink Toolbar on the bottom left of the 5D™ Embroidery window, click 5D™ 

Sketch . 

2. The Load Design Wizard- Design Options window opens. We will use the default, 
Load Picture for a New Embroidery. Click Next. 

3. Click Change Hoop. 

4. In the Enter Size box, select Enter Hoop Size. 

5. Change the Width to 25mm and the Height to 25mm. Click OK.  
6. Click Next. 

7. Select View Picture . 

8. In the Directory Browser click on the three dots .  

9. Find the folder Documents \5DEmbroidery \Samples \5DEmb \Pics2 

\Geometrics. Click on the arrows to open the folders as needed.  

10. Click OK to see the thumbnail previews. 

11. Click the first picture in the second row, 1cge06.  

We will use this picture for its shape. 

12. Click Next three times because we do not need to Rotate or Crop. 

13. On the Load Design Wizard-Picture Size, click Pick Color . 

14.  The mouse pointer is now a Pick Color pointer . Click on the darkest green. 

15. The Color Selection window opens. The Thread Range should be Robinson-Anton 
Rayon 40. Click in Find Thread and type 2319 Green Oak. Click OK. 

16. Click Next. 
17. On the Load Design Wizard-Add Alignment Stitches, in the Alignment Stitch Style 

box, select None.  

Alignment stitches are necessary when you are going to line embroidery designs 
with fabric that has a photo printed on it. We are creating a design element with no 
picture on the fabric. 

18. Click Finish. 

19. In the Control Panel on the upper right of 5D™ Sketch, click the Motif tab. 
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20. In the Motif box, the Group is set on Universal by default. If not, click the drop down 
arrow and select Universal.  

21. The Category is set on Candlewicking 1 by default. If not, click the drop down arrow 
and select Candlewicking 1. 

22. Click the drop down arrow next to Pattern. Select pattern 24. 

23. Select Mirror.  
This will put the connecting stitch at the inside of the circle. 

24. For Final Motif select Complete. 

25. In the Size box, change the Height to 9.0mm. The Width stays at 4.0mm. 
Proportional is selected. 

26. Since we want the design to have a vintage look, select Triple in the Stitch box. 

27. Click Draw Motifs . 

28. Hold and drag your mouse around the inside of the inner ring of the picture, about 
halfway between the center and the first ring out from center 
(see picture), counter clockwise starting at the vertical center 
grid line. Continue all the way around the circle.  

29. Right click to turn Draw Motif  off.  

If you do not like the look of your circle, click Undo . Click 

Draw Motifs , select Draw Motif, and draw a new circle. 

30. Click the Design tab. 

31. Click Save As . Save design as ‘Star Center’.  

32. Click Make Block From Visible Area . The design is now selected. 

33. Click Copy . 
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Finish Assembly and Create the Endless Design 
1. QuickLink back to 5D™ Embroidery.  

If you do not have 5D™ Sketch  load the file ‘Star Center.vp3’ into 5D™ 
Embroidery.  

2. Click Paste . 
3. Move the Zoom slider to 85%. 

4. Click the Overview tab and Pan  so you can see the Star Center design clearly. 
Move the design to the center of the Petal design. 

Adjust the View as needed with the Zoom tools. 

5. Click Duplicate . Move the Star Center to the other Petal design. 

6. Click Combine Design . 

7. Click ColorSort . 

8. Click Center in Hoop . 
9. Select the Edit tab. 

10. Click Change Order of Color Blocks . 
11. Click Merge Colors two times until there is only one color. Click OK. 
12. Click the Design tab. 
13. Click the color in Color Select. Change the design to any color you like. For a 

vintage look try an ivory.  

14. Click Endless . 
15. On the Endless Embroidery window, Options box, Fabric Direction is Up. 

16. The End Marker should be set on Corner. 
17. Marker Positions should be Both. 
18. Leave the Gap set at 0.0. 

19. Repeat Embroidery and ColorSort can remain checked even though 
we will have only one design in the hoop. 

20. Uncheck Remove Overlap.  
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21. Click OK to close the Endless window. 

22. Click on Save As . Save design as ‘Endless Vintage Design’.  
 
Be sure to open Preferences in 5D™ Embroidery, and place a check in Remove 
Overlap When Combining. 

 

This endless vintage design can be used on valances, tablecloths, shower curtains 
and many more home dec projects! 


